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Case story
This is a case story of, how to find the magnitude of a star.
Is it bright, is it dim? How is the photometry done?
The star in question is R CrB1, and the software is open source IRIS2 (for the photometrical data reduction), 
and  Cartes du Ciel3 (for stellar maps)
The hardware is the observatory at Goetheanum, Switzerland with its 18 cm refractor, and a Canon EOS 
550D camera.

AAVSO
The association of Variable Star Observers4 provides very fine help for observing variable stars. 
They present data for reference-stars5and finder-charts6.
They maintain a huge database of the variable star observations from observers all around the world.
The light curves can be visualized7, and as an observer one can upload observations8.

The star
R Corona Borealis is the 8.th star in the Northern Crown. https://en.wikipedia.org/wiki/R_Coronae_Borealis 
The brighter 7 stars lie like gems on a curved line east of Arcturus and west of Vega.
At the times of the Hipparcos mission (1991), the magnitude was VT = 5.959 (Tycho2 catalog)
This means, that the star was visible to the naked eye under fine conditions (no moon, well-adapted eyes 
etc.)

1https://en.wikipedia.org/wiki/R_Coronae_Borealis   

2Version 5.59 June 2010:       http://www.astrosurf.com/buil/us/iris/iris.htm 

3The English edition is called SKY CHARTS  http://www.astrosurf.com/buil/us/iris/iris.htm

4https://www.aavso.org/   

5 https://www.aavso.org/apps/vsp/photometry/?

fov=120.0&scale=C&star=R+CRB&orientation=ccd&maglimit=16.0&resolution=150&B=on&Rc=on&north=up&east=left&type=photometry 

6https://www.aavso.org/apps/vsp/chart/?  

fov=120.0&scale=C&star=R+CRB&orientation=ccd&maglimit=16.0&resolution=150&B=on&Rc=on&north=up&east=left&type=photometry 

7https://www.aavso.org/lcg/plot?auid=000-BBW-575&starname=R  

%20CRB&lastdays=400&obstotals=on&grid=on&pointsize=1&width=600&height=450&visual=on&uband=on&bband=on&v=on&r=on&iband=on&j=

on&h=on&unknown=on&fainterthan=on&unvalidated=on 

8https://www.aavso.org/webobs   
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When one zooms in on the celestial position with Cartes du Ciel, one gets this map.

The many dim stars are from the Digitized Star Survey DSS9, a map in a map.
When I first observed the position for R CrB, no particular star was seen. It was August 2015.
Can a star hide itself from being seen?

Procedure for data reduction with Iris software
This is a supplement to the very detailed description by Mark Blackford  found at the AAVSO website10 
(March 2016).
The roadmap used here deviates on several points from the roadmap of Mark Blackford.

Case A:
 Take 1 picture of the star R Crb. T= 30 sec, ISO 12800 
 Identify the star and a constant comparison stars on the finderchart from www.aavso.org

9http://archive.eso.org/dss/dss   
10https://www.aavso.org/sites/default/files/publications_files/dslr_manual/AAVSO_DSLR_Photometry_software_tutorials_V1-0.pdf     
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 Do the reductions as mentioned below,
 Submit your data on the green magnitude TG to the AAVSO

Step 1. Take a picture of the star
The equipment is seen on page 1.
The telescope is a fine old  Astro Physics StarFire EDT refractor with a 180 mm opening f/9.
The camera EOS550D is in prime focus, as can be seen on the picture. It is connected to the laptop-
computer with at USB-cable. The “EOS Utility”-program from Canon is used, so that the camera is controlled
mainly from the computer. The focusing procedure with the “live view” mode a very convenient.

As can be seen on the picture on page 1, the camera can be turned around the symmetry-axis of the 
telescope. It is convenient to have north up on the images taken. This means that one should rotate the 
camera in such a way, that if one moves the telescope in the East → West direction, the focused star should 
move along the long edge of the image.

The camera is used in Manual Mode with T=30 sec, ISO=12800 (witch is maximum), and the image was 
taken  2016-04-11 . It is saved as RAW-format on the computer, c:\Pictures\RCRB_2016_04_11_6859.cr2

Step.2 Identify the star
As mentioned earlier it can be a challenge to identify the star. The webpage w  ww.aavso.org    offers a great 
help in providing at finder-chart and a corresponding catalog of comparison stars.

On the front-page of www.aavso.org
one chooses “Pick a star”  and the
starname R Crb is written. Then
choose “Create a finderchart” . A
print of this chart is of great help
later, together with the Photometry
Table that belongs to the chart.

The coordinates of the target star R
Crb is seen at the top of the
finderchart, and the position of R Crb
is at the cross.

The star #127 (which later is chosen
as  comparison star) is seen close by.
The name indicates, that the V-
magnitude of the star is
approximately 12.7 mag. 
The asterism #111-100-102-119 is characteristic. It can be seen as “a little cannon” .
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In the Photometry Table it is seen, that the AUID-name for the #127 is 000-BBW-592 and V=12.666 ±0.021 
mag.

Step 3: Reduction with IRIS ver 5.59

The software is installed from http://www.astrosurf.com/buil/us/iris/iris.htm 
and  the file libdcraw.dll is installed as described. The camera EOS 550D is compatible with EOS 50D

Step 3.2 Initializing of IRIS

MENU:  File → settings

MENU: Find camera icon

Version 0.8 Photometry with IRIS Side 5 af 18

http://www.astrosurf.com/buil/us/iris/iris.htm


These are my choices. 
The Tycho2-catalog can be downloaded from  
www.astoft.dk/tycho2.zip 

Step 3.3. Transformation of the image from RAW-format to CFA

In the MENU line one chooses Digital photo → Decode RAW
This makes it possible to draw the stellar image to the program area with the mouse and Explorer:
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The new name is  @h
Clicking the CFA bottom produces the CFA-image with the name  ‘@h1’
IRIS produces the index 1 automatically.
This pictures is now active on the screen.

Step 3.3 Visualization

One of the fine qualities of the IRIS program is, that it is possible to visualize the image on the screen 
without changing the image itself. MENU point  View → Threshold
It changes the blackpoint and the whitepoint. Here the AUTO function has been used, and  it is seen that 
the blackpoint is 2141 ADU (That means that all pixels with values below 2141 are black) , and the 
whitepoint is 3341 ADU. The maximum intensity in one image is  2^14 – 1 = 16383 ADU, (because the chip 
on the EOS 550D is 14 bit) but the first 2048 is an offset, so that an absolutely dark image has the value 
2048 ADU. That is why the blackpoint is not near 0.

Step 3.4 Split the CFA image to 4 layers in FIT-format.

Now comes an important conceptual procedure: 
This CFA image contains  3465 x 5202 pixels
(approximately 32 MB on the hard-drive). But the pixels
are organized in Bayer Matrix pattern, 2 x 2, with 2 green,
1 blue and 1 red pixels.
Since the camera is used as a photometer, it is important
not to transform the values to JPEG or other nonlinear
formats. We use RAW-format, and separate all four layers
R G1 G2 B.
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When a star has been observed, the difference between the G1 and G2 is a good measure of the accuracy 
of the measurement.

Now I split the image @h1 into the four Bayer Matrix layers R G1 G2 B. They are called   c1, c2, c3 and c4.
(each approximately 8.802 MB on the harddrive) .
Find the command icon in the MENU line

And enter the command
>SPLIT_CFA   c1 c2 c3 c4
>load c2

Now  the original image is transformed to 4 fits files, and c2 and c3 should be very much alike, since the are 
both green.

Step 4. The instrumental magnitudes.

Now let us take a closer look at the image of the target
star (R Crb).
Draw a rectangle around the star with the mouse. 
Choose the menu-point shape

The diagram shows how the intensity decreases from the star center and outward. At a radius of r≈ 2-3 
pixels the intensity as almost halved.
The peak-signal is 2588 ADU above the background (2453 ADU), but the dark signal is only 2453-2048 = 405 
ADU due to the offset of the chip on 2048. 
The star is not saturated, because the peak is well below the limit
12.000 ADU

The star #122 is on the other hand saturated, as can be seen on a
similar diagram for that star. It has a flat top. This is the disadvantage
of using the high gain-factor with ISO 12800.
If a lower ISO-value of 200 ADU had been chosen, alle values would
be 64 times smaller, but that would reflect the number of photo-
electrons induced in the CMOS-chip better, and the dynamic range
would have been extended.
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4.1 The FWHM value

Let us return to the target star. Draw a rectangle around the star,
right-click and choose this time the PSF option. This showes
among other things that the FullWithHalvMaximum  FWHM≈  5
in both X and Y. This is the “diameter of the star”, in accordance
with the  r≈ 2-3 pixels found from the Shape-diagram above.

4.2 The aperture magnitude.

There are two methods to calculate the instrumental magnitudes. The aperture Photometry method and 
the PSF-method (PointSpredFunction). 
The PSF-method calculates a gauss-curve that fits the stellar image.It is often used by professionel 
astronommers with excelent optics. In DSLR photometry the optics may show some coma. In this case it is 
better to use the aperture meethod for calculating the magnitude.

Se the three circels around the target star. The innerradius r1 is 2 times the FWHM. The two outer circles 
define the  ring that measures the local background (here 390.6 ADU/pixel). That is subtracted from the 
intensity meaurede in the inner circle. The result is 67 830 ADU

This is used to calculate the instrumental magnitude 

m=−2.5 log (I )=−2.5 log (67830)=−12.079

This instrumental magnitude is relative to a (very faint) star with intensity 1 ADU. 
This gives the result, that the PSF magnitude for the star in the g1 filter is 
g1(star) = -12.079

A similar procedure for the comparison star #127 gives 
g1(comp)= -13.668
This star has a known V magnitude  ( V=12.666 ±0.021 mag.) on the catalog-scale where Vega has V=0.0 
mag. The observed magnitude of the star can now be calculated:

V(star) = V(comp) -g1(comp)+g1(star)  = 12.666 -(-13.668) – 12.079 =  14.255
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4.2 Time of observation

The image was taken 2016-04-11  01:14:33 CEST (UT + 2.00 h)
Central European Summer Time
The command
>INFO
As can be seen in the output-window shown to the right, the
command INFO gives the time of observation as 2 hour earlier. This
means that the time is correct in UT.
IRIS calculates this to Julian date.  

4.3 The first spreadsheet

When the procedure mentioned is repeated on the other green layer, c3, one gets TG2= 14.055 mag. That is
135 mmag less than before. So the result is 
TG = 14.12 ± 0.07 mag
These many numbers can be picked in a spreadsheet. 
I use Liberoffice Calc as a very powerful tool.
In the Output-window of IRIS one chooses Edit → copy
In Liberoffice Calc one chooses a cell “to the right” e.g  F6.   

Right click → Paste special

The text-import field comes forward. The “separator options” are 
important.

The idea is now to “pick” the relevant numbers from this area and
collect them in the left part of the spreadsheet.

It is seen that the magnitude of the star in c2 is in the 4th line.

Here is an explanation of the spreadsheet “Photometry with IRIS ver 1”
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The instrumental magnitudes from the two green layers c2 and c3 are picked from H9, H15, H21, H26. 
(yellow). They can be seen in cells B9:C10.
The catalog-value for the comparison star is in cell C15, 
and the calculated magnitudes from the two layers are in cell B16:B17
The resultant V-magnitude is seen in cell B19, and this value is copied to the first line (C2) that contains the 
results in a form that corresponds the format of the AAVSO.
The time of observation is picked from the output-window (H39 blue), and corrected in cells A23:C27.
The resultant JD is copied to the first line (B2)

The CNAME and the CMAG is the name of the comparison star, and the corresponding instrumental 
magnitude. The check-star (KNAME and KMAG) is not available (n/a) in this first case-story.

Step 5 Reporting the observation to the AAVSO
It is recommended to become a member of the AAVSO -organisation, but it is also possible just to register 
(that is to get a OBSCODE). 
The observation is submitted as a CSV-spreadsheet to https://www.aavso.org/webobs/file 
The format is described here
https://www.aavso.org/aavso-extended-file-format
This is the full example from above
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The Chart X18603O indicates to the Photometry Chart with the standard catalog values. 
The last line is copied from the Photometry spreadsheet with the “paste special” procedure.
This is the beginning of the observation protocol. Further observations can be added in the following lines.

Step 6 The procedure in short.
1. Menu   Digital Photo → Decode RAW   

1. The RAW image is ”drawn” with the mouse to the IRIS-program area.
2. New name  @h         CFA
3. command  >load @h1

2. Split the image to c1 c2 c3 c4
1. command     >SPLIT_CFA c1 c2 c3 c4

3. The PSF magnitude
1. Menu  Analysis → Display Data
2. Draw a rectangle around the star, click and choose  PSF

4. The observed magnitude
1. The PSF magnitude for the star and the comparison star are found from the c2 image and from 

the c3 image.
2. The command >INFO
3. The output-window is copied to the spreadsheet “Photometry with IRIS ver 1” in celle F6
4. The observed magnitude and the JD observing time are calculated and presented in a form to 

be read at the AAVSO
5. Observation protocol

1. The resulting line 2 in the spreadsheet is copied to the observation protocol
2. Further observations can be added before sending the results to www.aavso.org

Step 7 Final remark
This is the end of the first case story, “the simple start”. It is highly recommended to continue reading to the
next paragraph, where the images gets stacked, the background is subtracted, and vignetting is regarded by 
taking the flat-images. A more detailed spreadsheet is also presented to automatize the calculations of the 
magnitude and the error-estimate.
29-5-2017  ST
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#TYPE=Extended

#OBSCODE=TSCB
#SOFTWARE=IRIS5.59
#DELIM=comma
#DATE=JD
#OBSTYPE=DSLR
#NAME DATE MAG MERR FILT TRANS MTYPE CNAME CMAG KNAME KMAG AMASS GROUP CHART NOTES
R CrB 2457489.4684 14.12 0.07 TG no std 127 -13.62 na na na 1 X18603O



Case B:
 Take 14 picture of the star R Crb. T= 30 sec, ISO 12800 
 Make the traditional images : Dark, offset, flat in the four layers
 Do the reductions as mentioned below using a comparison star and more checkstars.
 Submit your data on the green magnitude TG to the AAVSO

Step 1: the image-series transformes from RAW til CFA and 4 fits-colour layers.

In the MENU line one chooses Digital photo → Decode RAW
This makes it possible to draw the 14 stellar images to the program area with the mouse and Explorer:

The new name is  @h
Clicking the CFA bottom produces the CFA-image series with the name  @h1, @h2, … ,@h14
@h is now the name of a series of images, not just one image.

The 14 images are split into four colourlayers 
@1-   @2-   @3-   @4- with the command

>SPLIT_CFA2  @h @1- @2-  @3- @4- 14
and the first green image is visualized11

>LOAD @2-1

and the stars from the finderchart are identified.

11 See step 3.3 Visualization earlier 
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Step 2: Dark offset flat
These steps are usually made in CCD-astrophotography. Since we are only interested in the Photometry, it 
can be done rather simple:
The image on the screen is 2601x1732 pixels.
The offset file is set to 0 ADU in all pixels, and the four dark images are set to 2048. The flatfiles are set to 
5000 in all four layers. These values can be refined further if necessary, but it takes many pictures in order 
not to introduce new sources of error. This is not done here.
>FILL 0
>SAVE offset
>FILL 2048
>SAVE dark1
>SAVE dark2
>SAVE dark3
>SAVE dark4
>FILL 10000
>SAVE flat-1
>SAVE flat-2
>SAVE flat-3
>SAVE flat-4

Step 3: Reduction
The series @1- is now reduced. First for the dark image, and afterwards for the flat-images
>OFFSET2 @1-  @@ dark1 14
>DIV2 @@ flat-1 @a1-  10000 14
This is repeated for the other 3 color layers #=2,3,4

>LOAD @a2-1
The split and reduction procedure described above has been collected to a script SPLIT16 (See Appendix 1). 
Is is called so
>RUN split16 14

Step 4: Stacking
The 14 green images will normally have a little offset in the
stars position from image to image. In IRIS this alignment is
done with the REGISTER command. But first one has to know
the limits. So the first thing to do is to animate the image-
series @a2-
Menu   View → Animate
The generic name is  @a2-
When one presses the go-button, one sees an animation of
the 14 images. 
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Choose an isolated non saturated star (like #122) and mark two imaginary points on a rectangle that 
contains the star, without the interference of other stars. The two points can be marked with the mouse, so 
their coordinates are seen in the output-window.
In this example (x1,y1)= (1249 ,1391)  and (x2,y2)=(1115 ,1125)
So the star moves 134 pixels in x and 266 pixels in y.
So a border of 300 pixels will leave a central part of the image  fit for the PREALIGN procedure.
The image size is  2601 x1732

>MOUSE_SELECT  300 300 2301 1432
>PREREGISTER @a2- @e2- 14
The new image-series @e2- is translated so that the stars has the same positions as in the first image.
These images are then added, and if the intensity supersede the maximum 32767, they are normalized, and
the normalization coefficient is shown.
The resulting image is called c2 as was the case in the first case story (A).

This is repeated for the 3 other layers. I have made a script PREALIGN (Appendix 2) that does this. It is called
in this way:
>RUN prealign 14 300 300 2301 1432

Step 5 Automatic photometry

As described earlier, one has to check the stars for saturation. [draw a rectangle around the star #122, and 
left-click on “shape”] If the top is flat, the star is saturated. It cannot be used as a standard star or a 
comparison star.
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Now it is time to chose the target star, the standard star and the comparison stars.
>LOAD c2
MENU  Analysis → Select Objects
Pick the stars (in this order)
#1  (the target star R Crb)
#127 (The comparison star)
#128 (the check star)
#122 (another check star)

The following procedure is usefull:
In the OUTPUT-window choose  EDIT → ERASE
MENU: Analysis → Automatic Photometry
By choosing the generic name c, one gets photometry in all four
colour-layers at the same time

It is seen that the instrumental green 
magnitude for the target star is
g1 = -13.000
g2 = -13.041
so  g = -13.020 ± 0.020 mag

The standardstar #127 has  
g = -14.439 ±0.002 mag 

These numbers are copied to a spreadsheet by choosing  
Edit → Copy
in this Output-window.

It is convenient to copy that to at separate sheet “i-mag”  ( Copy
special) and then making the calculations in the first sheet “Results”

The final result is seen in the first line as in caste study A

TG = 14.085 ± 0.023 mag  
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Appendix 1
***************************
**  RUN SPLIT16  $1
** where $1 is number of images named @h1, @h2, ... @h$1 in CFA format
** ST 1.juni 2017
** First procedure for evaluation of stellar images with IRIS version 5.59
****************************************************************
** The stellar images are transformed form RAW-format (CR2) til fits choosing
**  Digital Photo -> Decode RAW Files
** and the files is drawn with the mouse to the program-area. 
** The new name is @h  (CFA)
****************************************************************
** The results are the 4 colour layers  R G1 G2 B  ;
** reduced image-series @a1-  @a2- @a3- @a4-
****************************************************************
** Assumptions:
** Four layers of  dark# (typicly 2048) are subtracted.
** The images are divided by flat-1, flat-2 flat-3 flat-4 
** and multiplied by 10000
** No hot-pixels  ; #= 1,2,3,4   R G1 G2 B
** the constant Offset is not used.
** the intermediate series @@ is used
**********************************************************
Load @h1
info
echo split_@h_in_R_G1_G2_B_layers:
SPLIT_CFA2  @h @1- @2- @3- @4- $1
**
OFFSET2 @1-  @@ dark1 $1
div2 @@ flat-1 @a1- 10000 $1
OFFSET2 @2-  @@ dark2 $1
div2 @@ flat-2 @a2- 10000 $1
OFFSET2 @3-  @@ dark3 $1
div2 @@ flat-3 @a3- 10000 $1
OFFSET2 @4-  @@ dark4 $1
div2 @@ flat-4 @a4- 10000 $1
LOAD @a2-1
echo split_done
END

Appendix 2
***************************
**  RUN preALIGN  $1 $2 $3 $4 $5
** where $1 is number of original images in CFA format
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** ST 29.maj 2017
** A helping procedure, when alignment is difficult
** The input are the four series  @a1- @a2- @a3- @a4-
** Before running ALIG the user must find the two corners ($2,$3) and ($4,$5) of the recktangel 
** that contains a caraktiristic stellar form
****************************************************************
** The output of the procedure are the four series  @e1-  @e2- @e3- @e4-
** and the mean of the four layers  c1, c2, c3, c4
**********************************************************
echo preALIGN_procedure
echo _

load @a1-1
mouse_select $2 $3 $4 $5
preRegister @a1- @e1- $1
add_norm @e1- $1
save c1
echo 1
load @e2-1
mouse_select $2 $3 $4 $5
preRegister @a2- @e2- $1
add_norm @e2- $1
save c2
echo 2
load @a3-1
mouse_select $2 $3 $4 $5
preRegister @a3- @e3- $1
add_norm @e3- $1
save c3
echo 3
load @a4-1
mouse_select $2 $3 $4 $5
preRegister @a4- @e4- $1
add_norm @e4- $1
save c4
echo 4
**
**load @a1-1
**info
Load c2
echo c2_loaded
echo Select_stars_and_run_automatic_photometry
echo c_med_4_observationer
END
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